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Joint Roughness Coefficient (JRC) was developed in the early 1970s by Barton and has become the backbone
of many equations to estimate the shear strength of defects within a rock mass. The roughness of defects is,
however, difficult to estimate using visual and tactile methods, with significant variation noted across
workers depending on their educational/mentoring background, industry, and exposure to defect assessment.

Barton’s chart is a common reference for visual estimation, whilst the sandpaper methods provide support
to tactile methods; however, none of these are consistent as it is difficult to synthesise a three-dimensional
surface to a two-dimensional profile in a field setting. The use of contour gauges assists in this process,
allowing the profile of a surface to be compared against Barton’s chart, however, this still leaves a
significant pathway to error, depending on the judgement of the practitioner.
Whilst some work has been done to standardise the approach of digital analysis, it relies on bespoke
software, currently constrained by sanctions, or very controlled input methods using custom made
mechanical devices to collect field data.

The method described herein provides a process using open source and off-the-shelf software, and
spreadsheets to digitise defect traces consistently, extracting profile geometry, and allowing the profile to be
processed to calculate the JRC and ‘i'. It provides an a) overall JRC, b) a trimmed JRC, which reduces the
issue of end effects on contour gauge profiles, c) a dynamic JRC, accounting for the often-short profiles
observed in core, d) an estimate of ‘i’ (at profile and internode spacing), and e) the initial dilation angle.
This process has been trialled using a significant database, resulting in the ability to select an appropriate
and consistent JRC across different defect sets, and an appropriate ‘i' value for use in the assessment of the
stability of the dam.
Further, the other major input to the Barton Shear Failure Criterion, phib or phir suffers from inconsistencies
in the testing process and interpretation, resulting in the adoption of values which may not represent the true
characteristics of the foundation. The testing and commonly applied correction, the Hencher Correction, is
discussed herein to provide some insight into the development of a robust, defensible database for use in the
development of foundation strength models for dams, particularly those with foundations considered to be
‘Not Well Defined’.
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Introduction
Joint Roughness Coefficient (JRC) is an essential input to the Barton Shear Failure Criterion and is coupled with the Basic
(Phib) or Residual Friction Angle (Phir), the Joint Compressive Strength (JCS), and the Normal Stress, in order to estimate
the strength of a defect. Of these inputs, the JCS and Normal Stress are relatively easy to determine. The basic or residual
friction angle of the defect is generally determined using laboratory direct shear tests of defects collected from blocks,
though usually from rock core. The determination of JRC generally falls to visual estimation from defects observed in
outcrop or core, or correlation from recorded shape and habit to an equivalent roughness. This visual estimation, results in
significant variation in the range of roughness estimated for input, and where multiple practitioners are involved, a
significant range can result, particularly across holes or mapping areas where workers have operated in isolation of one
another.
Some researchers have attempted to build methods of digital determination of JRC, however, on enquiry, these have been
discontinued due to the imposition of international sanctions on researchers in some countries due to ongoing international
conflicts or the cessation of projects for which the systems were being developed. Out of necessity, the method detailed
herein was developed, and whilst it is not considered to be perfect, we provide a strong foundation for others to help us
carry this forward to a method that can provide consistency across the industry, both in Australia and New Zealand, and
further afield.

This paper details those foundations, as the pathway to a [semi-automated] solution to estimating the Joint Roughness
Coefficient for projects, in addition to discussing issues and corrections applied to the other Barton-Bandis input; the Basic
or Residual Friction Angle which can significantly alter the defect strength estimate.



Joint Roughness Coefficient
Barton & Choubey’s (1977) profiles (Figure 2) have been reproduced in numerous papers since their original publication,
and have been used as a guide to the estimation of Joint Roughness Coefficient in the field. For everyday use, those
responsible for the assignment of JRC in the field visually match the prototype to those in Barton & Choubey (1977) and
are not always aware of the method of numerical estimation or are often young practitioners who have not had to utilise
JRC in design situations, and are unaware of the implications of incorrect JRC assignment. Further, the profiles are often
reproduced at reduced scales resulting in misclassification.
Visual review of Barton & Choubey’s profiles show an increase in asperity with each step change in JRC to a JRC of 10,
however the profiles between 10 – 20 show significant steps, with significant amplitude changes, which are not in keeping
with the increasing roughness (amplitude vs profile length) as detailed in the original (1977) text. Using the methodology
described in this paper, the JRCs were estimated using Barton & Choubey’s profiles, the results of which are provided to
the right of the original, intended, JRC range. The yellow arrows on Figure 2 show significant inflections and departures
from the reference line, along which the amplitude is calculated. Whilst small scale roughness is increasing as the JRC
increases, the significant large-scale protrusions result in higher JRCs and likely rock shearing. The profiles have been re-
ordered showing increasing roughness and amplitude with increasing JRC.
Barton & Choubey’s JRC profiles range from JRC = 0 – 20, with 20 considered to be the transition from a defect controlled
failure scenario to a rock mass controlled failure scenario, with the Geological Strength Index (GSI) of the rock mass
accounting for the fracturing and character of the defect surfaces. Whilst JRC = 20 marks an accepted limit of JRC, there
is precedent for higher JRCs, with JRC > 30, or 32, reported by Baczynski (2025). Figure 1 provides a modified version of
Barton & Choubey’s magnitude plot, extended to allow core scale profiles to be plotted, in addition to displaying JRC
results in excess of 20, which would generally result in the failure being rock mass controlled as opposed to defect driven.

Figure 1 Modified version of Barton & Choubey's JRC Amplitude vs Profile Length chart, showing extensions for core-scale JRC and
JRC > 20, with rock-mass controlled failure zone (red hachured area).

Methodology
The primary input for the assessment of Joint Roughness Coefficient is the defect surface profile. The orientation of the
profile can significantly alter the overall profile roughness depending on the rock fabric. In some cases, defect profiles
oriented parallel to the fabric of the rock may report very low JRCs, whilst those profiles oriented normal to the fabric, can
have significantly higher JRCs, although measured on the same surface.



Figure 2 Barton & Choubey's (1977) Joint Roughness Coefficient profiles, commonly used for visual estimation, with re-estimated JRCs,
re-ordering, and re-scaling, of the original traces in order of increasing roughness based on the Dynamic JRC. Note Dynamic JRC
values which correct for scale effects and significant departures (circled).



Data collection
A conventional 150 mm contour gauge is required to acquire the defect surface trace in the field, and is considered suitable
for core to outcrop scale observations. Several different types of gauge are available, the most common being those with
plastic fingers [or combs], however these provide a stepped and coarse resolution trace. The preferred gauge is a steel wire
fingered/comb gauge, with a wire diameter of no greater than 0.75 mm to avoid significant artefacts being introduced.
In our experience, the Empire 2754M or General Tools 837 gauges are reliable and provide good repeatability. A 0.5 mm
mechanical pencil provides good compatibility with the wire comb, resulting in a trace that provides a good representation
of the surface. Thicker pencils or pens will result in smoothing of the profile.
A standard defect profile collection card has been developed to a standardised collection method, allowing effective image
and repeatable image registration. An example of the contour gauge profile on a data collection card is provided as Figure
3, and the digitised defect as shown in Figure 4.

Figure 3 Example of defect surface profile on registration card.

Figure 4 Example of digitised defect trace.

Dynamic JRC
Barton & Choubey (1977) use three (3) scaling factors to calculate the JRC: 400 for profiles of 0.1 m, 450, for profiles or
1.0 m, and 500 for profiles of 10.0 m. When estimating JRC on profiles shorter than 0.1 m, such as profiles traced from
core, the minimum divisor of 400 amplifies the JRC. To account for this, a Dynamic JRC was developed, which calculated
the appropriate divisor based on the length of the profile using Equation 1, resulting in a lower, more representative, JRC.



Equation 1 Equation to calculate ω.

𝜔 = 21.714724 ×  ln(𝑃𝑟𝑜𝑓𝑖𝑙𝑒 𝐿𝑒𝑛𝑔𝑡ℎ (𝑚)) + 450

Equation 2 Equation to calculate JRC.

𝐷𝑦𝑛𝑎𝑚𝑖𝑐 𝐽𝑅𝐶 =
𝐴𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒 (𝑚𝑚)

𝑃𝑟𝑜𝑓𝑖𝑙𝑒 𝐿𝑒𝑛𝑔𝑡ℎ (𝑚𝑚)
× 𝜔

Reference Line
The traced profile often features artefacts within the first few millimetres of the trace as the user establishes their pencil
against the contour gauge and then finalises the trace. This can be removed from the assessment by incorporation of a
buffer zone, which is suggested as 2.0 mm. A straight line (reference line) is established between these two points. At
regularly spaced increments along the reference line, generally set at 0.25 mm, the distance between the reference line and
the defect trace is calculated, and adjusted for the slope of the line to ensure a true amplitude (as opposed to a hypotenuse)
is returned (refer Figure 5). The start and end points of the reference line can be set by way of the buffer or manually
controlled to assess specific intervals along the defect trace.
It is noted that the reference line is simply a reference line above and below which the maximum magnitude, relative to
that line is calculated. Where the maximum magnitude of the defect is required, the reference line is manually controlled
so as to only display the profile on one side, which results in an increase in the JRC. However, in practice, it is suggested
that this is not a true reflection on the JRC that is witnessed by the defect as the failure surface will not locate itself so as
to result in the maximum shearing effort, more so a surface that sits nearer the midpoint of the profile such that the shearing
or dilational effort is minimised. Further, the defect profile observed is a very small section of the prototype defect which
may extend for many decimetres, metres or tens of metres, thus, the precision of ensuring the magnitude is calculated from
a reference line that maximises the JRC is questioned. It is suggested that developing a database of JRCs from many profiles
provides a more robust estimate of JRC across the foundation, as opposed to the refinement of the JRC estimates on a
single profile.

Figure 5 Profile amplitude from reference line.

‘i’ at Two (2) Scales
The interlimb or ‘i’ angle is calculated at two (2) scales:

1. from one node to the next node, at the preset assessment increment (usually 0.25 mm); and
2. at a larger scale, set by the user, often 10 mm.

The node-to-node calculation of ‘i’ can result in high values, which can approach 90°, however typically range below 35°.
The large-scale ‘i’ estimate typically soften the severity of ‘i’, and presents values considered to be more appropriate for
use. Should methods other than the Barton Shear Failure Criterion be used (i.e. Patton’s Method (1966)), the use of large-
scale ‘i’ is recommended. It is, however, of importance to note that the BC Hydro (BCHydro, 1995) suggested limit of i =
10° be strongly considered should this approach be applied.
Within the Barton Shear Failure Criterion, ‘i’ can exceed 10°, often ranging well above 30°, however this is acceptable
provided the ultimate value is less than 70° (Wyllie & Norrish, 1996).
Figure 6 illustrates the difference between the small- (0.25 mm) and large-scale (10 mm) ‘i’ for a single profile.



Figure 6 Plot showing internode 'i' (blue traces) and large-scale (10 mm) 'i' (yellow traces).

Rock Bridges
To develop an understanding of the amount of rock-rock interaction along a shear surface, a shear surface is fitted through
the defect. The thickness of the shear zone is set using dilation observations from rock core and in outcrop. The algorithm
within the spreadsheet calculates those elements of the joint surface where the protrusions exceed the thickness of the shear
zone. The length of the defect where the dilation or shearing of rock will occur (as illustrated in Figure 7) is calculated as
a percentage and engagement zones highlighted above and below the trace.

Figure 7 Left) Example of identified rock-bridges on joint surface (indicated by blue traces above and below the profile), and Right) the
process of dilation and shearing (arrowed) (Wyllie & Norrish, 1996).

Phib & Phir
In addition to JRC, the basic or residual friction angle is a critical input to the Barton Shear Failure Criterion, and the
reliability of this value can significantly affect the result utilised in the assessment of the defect strength.

Laboratory Testing
Several issues have been noted with direct shear tests completed by laboratories, with the main concern relating to the
methodology. Whilst a Standard exists for the majority of the test, the way the test is actually performed is at the discretion
of the laboratory or commissioning engineer. The issue specifically relates to how the test is staged, with the scenarios as
provided in Table 1 being common variations noted from testing reviewed during this study.



These tests may also be completed in a wet or dry condition, which further complicates the analysis of the data.

Table 1 Direct shear testing variations commonly observed in laboratory results.

Sequence

Variation
1 2 3 4 5 Repositioning

& Condition

Variation A
Minimum Load
Peak to Residual
(Full Strain)

Medium Load
Peak to Residual
(Full Strain)

Maximum Load
Peak to Residual
(Full Strain)

 Reversal
(Strain
doubling)
 Lift and Reset
 Lift, Clean,
and Reset

 Wet
 Dry

Variation B
Minimum Load
Peak (Partial
Strain)

Medium Load
Peak (Partial
Strain)

Maximum Load
Peak to Residual
(Full Strain)

Minimum Load
Residual (Partial
Strain)

Medium Load
Residual (Partial
Strain)

Variation C
Minimum Load
Peak (Partial
Strain)

Medium Load
Peak (Partial
Strain)

Maximum Load
Peak to Residual
(Full Strain)

Medium Load
Residual (Partial
Strain)

Minimum Load
Residual (Partial
Strain)

Variation D Any bespoke order, strain or load requirements of the commissioning engineer or geologist.

Three (3) further, and significant, issues were identified regarding the geometry of the sample, specifically: a) the area of
the sample, b) the inclination of the sample at strain 0.0 mm, and c) the orientation of the sample fabric during testing.
Sample Area
The interpretation of the results requires both the shear and normal stresses to be known, however the normal stress applied
to the sample increases as the sample is displaced horizontally and the area in contact reduces; with the normal force
remaining constant. The normal force is typically corrected by assuming a rectangular or elliptical (or circular) area
equation. When the samples are rectangular or elliptical (or circular), there is no issue utilising these corrections; however,
the sample being tested is often inconsistent with these shapes, thus the area utilised in the correction is an approximation
at best, with significant increases or reductions in area not considered. This results in an area corrected normal stress that
is incorrect and can significantly alter the results.
Figure 8 Example of Top Left) Elliptical sample, and Top Right) Sample considered elliptical for stress correction, and Bottom Left)
Rectangular sample, and Bottom Right) Sample considered rectangular for stress correction.

Sample Inclination
Analysis of the vertical dilatometer data from laboratory testing indicated that at strain 0.0 mm, the test sample is often
oriented in an inclined backward orientation, referred to as ‘wakeboarding’. In rare circumstances, the sample is tilted
forward, referred to as ‘snowploughing’. Using the dilatometer data, the slope and aspect of the sample are calculated at
each strain position, and the change in orientation mapped as the test progressed, allowing changes in sample geometry to
be identified (Refer Figure 9). This initial orientation is related to a limitation of the direct shear testing apparatus, where
it has been identified that samples set perfectly level can result in the push rod sliding below the receiver and terminating



the test. Similarly, a forward inclined [or horizontal] sample can result in the leading edges of the boxes engaging,
terminating the test. Thus the sample is deliberately set to wake-board, but this not accounted for in the result. As an initial
dilation is applied, as opposed to the test being able to ‘find’ its own pathway forward, the peak stress is potentially reduced,
also delaying the residual. This is, however the topic of further study.

Figure 9 Examples of Lef) Wakeboarding (backward tilted) sample, and Right) Snowploughing (forward tilted) sample.

Orientation of Sample Fabric
The direction of shear will have a significant impact on the laboratory test result, as the asperity of the sample in each
direction will result in increased or decreased shear strength. Should shearing occur across the grain, additional dilation of
the sample, or shearing of the rock must occur to allow the sample to slide, whilst, should movement occur along the grain,
this dilation or breakage of rock does not necessarily need to occur. A simple analogy are two (2) sheets of corrugated iron.
Depending how the sample is set in the box, and whether the orientation and direction of shear has been determined by the
commissioning engineer or left to the discretion of the laboratory, the test result can vary significantly, thus the value of
the data may be questioned; particularly where the databases are of limited size. In larger databases, the outliers caused by
the sample and direction of shear orientation, are more identifiable, though affect the 20th percentile values required for
those foundations considered to be ‘Not Well Defined’.
An example of the significant variability in surface roughness due to the grain of a sample is provided in Table 2 and Figure
10. This example is from a block of Rocksberg Greenstone, with the JRC calculated along the grain of the rock fabric, at
45° to the right, normal to (i.e. across) the grain, and at 45° to the left (315°). This issue of orientation dependent variability
requires serious consideration when estimating the defect shear strength using Patton’s Method (1966) or the Barton Shear
Failure Criterion (1990). Both the orientation selected to estimate the JRC and the orientation selected during direct shear
test will result in significant, and potentially large, changes in the estimated defect strength, noting the maximum JRC is
more than double the minimum. The changes in strength can be adversely affected in both directions – either too high or
too low depending on the combination of orientations applied.

Table 2 Variation in JRC depending on profile orientation.

Orientation JRC Dynamic JRC Large-Scale i

000° (With the grain) 7.7 7.9 3.0°

045° (Oblique to grain: Right) 9.8 10.0 4.6°

090° (Across the grain) 15.6 15.9 5.2°

315° (Oblique to grain: Left) 7.4 7.5 2.6°



Figure 10 Variation in JRC profile with orientation. Top-Left) 000° (With the grain), Top-Right) 045° (Oblique to grain: Right), Bottom-
Left) 090° (Across the grain), and Bottom-Right) 315° (Oblique to grain: Left).

Hencher Correction
The raw Hencher correction plot provides a trace with significant variation, resulting from the correction of the shear and
normal stresses using a combination of the ‘i’ value determined at that strain location, and recorded forces and areas.
Depending on whether the sample dilation is positive or negative, the value of ‘i’ may rise and fall, giving rise to the saw-
tooth pattern (refer Top-Left Figure 11). As this data is difficult to interpret, laboratories and practitioners smooth the trace
using a moving average solution, with some noted to moving averages in the order of twelve (12) points. Examples of the
change in shape and values of the Hencher corrected traces are provided in Figure 11.
As can be seen, the shape of the curve, and the position with regard to the shear stress, changes significantly, thus any
interpretation based on this type of curve introduces significant error.
The raw Hencher corrected data is, as based on Hencher (2014), plotted on a Shear-Normal stress plot, and the Peak and
Residual values are interpreted from the laboratory data. These points are adjusted, as needed, by stepping away from the
interpretation point, by one increment at a time, positive, then negative, then positive, then negative, until such time that
the interpretation point falls nearer the midpoint of the Hencher correction cloud for that test stage, as shown in Figure 12.
Based on a recent study, it was noted that reinterpretation of laboratory results saw an average increase in Peak shear-
strength, before being reduced by the Hencher correction. The comparisons between the correction stages are provided in
Table 3.

Table 3 Comparison of laboratory and interpreted results.

Statistic
Laboratory Result to
Reinterpreted Result

Reinterpreted Result to
Hencher Correction

Laboratory Result to
Hencher Correction

Average 103.8% 94.4% 98.0%

Standard Deviation 7.2% 12.9% 12.7%

Minimum 90.9% 60.6% 68.3%

Maximum 129.5% 136.3% 139.4%

Applied Phib or Phir
Whilst direct shear tests have been used for decades, the accuracy of the result is questionable given the inherent variability
in the process and results depending on who commissions and who executes the test. The value of the Hencher corrected



data is also questionable, given the issues associated with the calculation of the sample area, and thus the corrected normal
stress. A far simpler, much less expensive, and more time efficient approach to the determination of the basic or residual
friction angle is by way of Tilt Tests using a tilt table similar to that shown in Figure 13.
Tilt tests can be completed quickly, without the need for bespoke and time-consuming sample preparation and mounting,
using a simple apparatus with a slow, and controlled rate of tilt, with a dilatometer used to measure the angle at which
sliding commences. Further, the test can be completed on blocks or core samples, with the sample dimensions only required
to have a height less than the length and width of the sample to prevent initiation of movement by way of toppling. Sample
surface area corrections are also not required.

Figure 11 Hencher corrected stress plots showing Top Left) Single point moving average, Top Right) Four (4) point moving average,
Bottom Left) Eight (8) point moving average, and Bottom Right) Twelve (12) point moving average.



Figure 12 Example of Uncorrected and Hencher Corrected stress data, showing inflection points and cloud fitting.

Figure 13 Example of tilt test apparatus (Image source: https://controls-group.com/it/product/dispositivo-di-prova-del-coefficiente-di-rugosita-del-
giunto/)

Conclusion
Rather than using subjective joint roughness classification systems, such as comparison to profiles, some of which are in
error, or using correlations between shape and surface texture, which vary depending on the Standard under which they
were recorded, this process allows the consistent classification of defect surface profiles. The collection of defect surface
profiles, and the digitisation and analysis of the same, using the methods described herein allows for the rapid and
repeatable development of a robust database of joint surface condition, irrespective of which worker collects and processes
the data. This data can then be mined using spreadsheet macros to compile the results, allowing statistical analysis and the



selection of appropriate input values for use in the development of defect strength inputs using methods such as the Barton
Shear Failure Criterion, allowing tens to hundreds of profiles to be considered.
Further, the derivation of the Peak or Residual Friction Angle, which is also required in the Barton Shear Failure Criterion
is critical, and requires a similarly consistent and repeatable approach, sufficient to provide the required input. The methods
upon which analyses rely are fraught with inconsistencies and errors, resulting in the development of values which may
not accurately represent the true strength of the defect surface. It is proposed that rather than relying on direct shear tests,
and applying corrections which seek to provide a precise result from an imprecise test, a simpler test be utilised to allow
the development of a larger, more repeatable database, similar to that of the JRC. The use of a tilt table will allow the
sample to be tested in different orientations; with, and across the grain, providing greater insight into the potential
foundation strength. This will also avoid significant downward skewing of the results where specific samples (such as
slickensided surfaces) may be tested in quantities that greatly over-represent their abundance in the database when
compared to the prototype. The skewing and bias becomes particularly important when 20th percentile values are selected
for those foundations considered to be ‘Not Well Defined’.
It is proposed that this system be developed further, to include the automation of the digitisation and analysis process
through the development of software code to register, trace, and transfer the profile from QGIS, through Excel, and into
Grapher, reducing the human input and greatly improving the rate at which profiles can be processed, a process currently
averaging less than ten (10) minutes per profile. It is intended that this process be transferred to an Open-Source
environment, with acknowledgment of the original authors, for the progression of the industry.

Processing Guide
System Requirements
The method uses three (3) common software packages to process, analyse, and present the defect surface characteristics:
QGIS (an Open-Source Geographic Information System), Microsoft Excel, and Golden Software’s Grapher. Hardware is
limited to a Windows based computer (for Grapher), a scanner, a contour gauge, and a consistent image registration card.
All of these items are available off the shelf.
QGIS
QGIS (also known as Quantum GIS) is an Open-Source Geographic Information System, selected for its ability to
accurately transform a defect surface trace from a scanned image or photograph to a polyline accurately and rapidly. Raster
Tracer is a plugin for QGIS that is utilised to automatically trace the defect surface profile, converting it to a digital line
available for interrogation. The GitHub repository for the Raster Tracer is: https://github.com/mkondratyev85/raster_tracer
and was developed by Mikhail Kondratyev.
Microsoft Excel
A bespoke spreadsheet was developed in Microsoft Excel to process the data output by the QGIS process. This spreadsheet
allows the calculation of the magnitude from the reference line and the corrections associated with the slope of the reference
line, in addition to the internode, and large scale ‘i’ values.
Golden Software Grapher
Grapher allows the graphic presentation of numerical data in a far more advanced environment, and with significantly
greater graphical control than conventional all-in-one spreadsheet solutions.
Methodology

1. Trace the defect on the MTG Joint Roughness card using a 0.75 mm wire comb contour gauge and 0.5 mm mechanical pencil with no harder
than 2B lead.

2. Open Scanning Software:
a. Scan the MTG Joint Roughness card in colour at 600 DPI.
b. Review the scan. If any artefacts are noted, increase the resolution and, if the scanner allows, change the image type to ‘Photograph’.
c. Save the image as JPEG with the compression method set to High Quality or Lossless.

3. Open QGIS:
a. Create a User Defined Projection. This only has to be done the first time this process is completed.

i. Settings > Custom Projections
ii. Click green + button.

iii. Name: JRC
iv. Format: Proj String – Legacy
v. Parameters:

+proj=omerc +lat_0=0 +lonc=0 +alpha=45 +gamma=0 +k=1 +x_0=1000 +y_0=5000 +ellps=WGS84 +towgs84=0,0,0,0,0,0,0 +units=m
+no_defs +type=crs

b. Set the ESPG for the workspace to EPSG: 100000 - JRC
c. Layer > Georeferencer

i. Open the saved JPG image.
ii. Transformation Settings (Yellow Cog) > Choose Projection (Target CRS): JRC

iii. Set the Transformation Type > Helmert.



iv. Set the Resampling Method > Nearest Neighbour.
v. Set Output File > Same Filename as JPG – though save as TIFF

vi. Leave all other values as default.
vii. Register the MTG Joint Roughness card using the four (4) defined registration marks (noting x is the 1000).

viii. Click the PLAY button to process the registration.
ix. Close the Georeferencer.

d. The map window should show the Georeferenced JRC Card.
e. Open the JRC Chainage Array SHP file.
f. Open Raster Tracer Plugin.

i. Create a new SHP File > Geometry type LineString – named as per the TIFF.
ii. File Encoding > UTF-8

iii. Change Projection to User Defined.
iv. New Field > Name ‘Trace’. Type: Text. Length: 80. > Add Field to List.
v. Set the SHP file to editable and Select the layer.

vi. Use the trace tool and click at the start of the Joint Trace by clicking along the trace and allowing the software to trace
the shape.

vii. Check the trace is accurate and no artefacts exist. Artefacts are possible on occasion, and it has been noted that closing
QGIS and re-opening the software resolves this issue.

viii. Make the file non-editable and save changes to the file.
g. In the Processing Toolbox, select Line Intersections tool.

i. Set the Input Layer as the Traced SHP file.
ii. Set the Intersect Layer as the JRC Chainage Array SHP file.

iii. Set to Keep All Fields.
iv. Click > Run.

h. Right-mouse click the new Intersections SHP file in the Contents Tree and Open Attribute Table
i. Set to Editable
j. Add New Field and name as Raw X, and set type to Decimal: 20, 2
k. Add New Field and name as Raw Y, and set type to Decimal: 20, 2
l. Select Raw X = $x and Update All
m. Select Raw Y = $y and Update All
n. Click Save
o. Set to non-editable.
p. Select Intersections Layer and right mouse click; select Export > Save Feature As > Format: SHP. Add filename. Set CRS to JRC.
q. Close QGIS.

4. Open Microsoft Excel:
a. Open the MTG Joint Roughness Calculator
b. Navigate to the DBF File associated with the SHP file created in 3.g and open this file.
c. Copy the three columns – Chainage, Raw X, and Raw Y
d. Paste the three columns – as values – into the Yellow shaded cells of the same name in the MTG Joint Roughness Calculator.

5. Open Golden Software’s Grapher:
a. Open ‘Joint Roughness Calculator – Rev C3.grf’
b. Click Remap > Point Grapher to the saved XLSX spreadsheet for the Barton Amplitude and JRC Estimation Sheet.
c. Adjust the Scales for the three graphs (Labelled: Change Me) as noted in the blue text to the right of the Defect Profile plot. The

X-axis should automatically scale.
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